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Create a Google Account

A Google Account lets you access a variety of Google products such as Gmail, Google+, YouTube, and many
more. A Google Account includes a Gmail address and a Google Profile, which will help you have a richer, more
personalized experience across Google products.
You can create a Google Account by going to the Account Creation page (https://accounts.google.com/signup),
or by clicking the Create an Account button on the top-right corner of any Google sign-in page. You can use your
Google Account with all Google products, so once you create an account -- regardless of whether you do it through
the Account Creation page or through a specific product’s sign-in page -- you can use that username and password
with any Google product.
Let’s say that you want to start using YouTube to post your videos. You go to www.youtube.com, and create a
Google Account. Not only can you use that username and password combination to sign in to and start posting
videos on YouTube, you can also use it to create and share documents in Google Docs.
We’ll send all emails about your account and product usage to your new Gmail address, which will be your
username@gmail.com.
When you create your account, we’ll ask you for some information to provide you with a secure and personalized
Google experience. Learn more about the information you provide at sign-up
(https://support.google.com/accounts/answer/1733224).
If you're not sure whether you have a Google Account, you can visit the Google Account
Recovery (https://www.google.com/accounts/recovery) page to determine if your email address is associated with
an existing account.

Google Drive

Google Drive, Google+ Photos, and Gmail give you storage space for free so you can keep your files, email, and
photos accessible from any device, anywhere.

Free storage

Google Drive and Google+ Photos

Gmail

5 GB shared between Google Drive and Google+ Photos

10 GB for messages and attachments

If you reach the free storage limit, everything in Google Drive, Google+ Photos, and Gmail will still be accessible,
but you won't be able to create or add anything new over the free storage limit.
•

Google Drive and Google+ Photos: If you've reached or exceeded the free storage limit, you won't be
able to sync or upload any new files, and syncing between your Google Drive folder and My Drive stops
completely. You'll still be able to create Google Docs, since they don't take up any storage space. For G+
Photos, you will only be able to upload new photos and videos under certain size limits.

•

Gmail: If you've reached the 10 GB free storage limit, all new incoming emails will be returned to its
sender. This means your inbox will be full, and you won't receive new email.
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How Google Drive storage plans work

If you run out of free storage space, Google offers a way to purchase additional storage space shared between
Google Drive and G+ Photos. With the purchase of any Google Drive storage plan, your Gmail storage limit will also
increase to 25 GB of total storage.
The storage plans described here are for personal use. Looking for business storage? Purchase Google
Drive storage for your business (http://support.google.com/a/bin/answer.py?hl=en&answer=177064).
Here are a few important things to know before purchasing a storage plan:
•

Google Drive storage purchases are subscriptions that automatically renew. You can cancel your
subscription at any time, but storage purchases are non-refundable.

•

You can make changes to your storage plan at any time. You'll be upgraded to your new storage level
immediately, and your credit card will be charged when you run out of credit.

•

A storage plan for one Google account can't be transferred to a different account.

•

It can take up to 24 hours before purchased storage is added to your account.

•

This storage has limitations for Google Apps users. Learn more
(http://support.google.com/a/bin/answer.py?hl=en&answer=1047457).

Docs, Sheets, and Slides
What are Google Docs, Sheets, and Slides?

Google Docs, Sheets, and Slides are productivity apps that let you create different kinds of online documents, work
on them in real time with other people, and store them in your Google Drive online — all for free. You can access
the documents, spreadsheets, and presentations you create from any computer, anywhere in the world. (There's
even some work you can do without an Internet connection!) This guide will give you a quick overview of the many
things that you can do with Google Docs, Sheets, and Slides.
Google Docs

Google Docs is an online word processor that lets you create and format text documents and collaborate with other
people in real time. Here's what you can do with Google Docs:
•

Upload a Word document and convert it to a Google document

•

Add flair and formatting to your documents by adjusting margins, spacing, fonts, and colors — all that fun
stuff

•

Invite other people to collaborate on a document with you, giving them edit, comment or view access

•

Collaborate online in real time and chat with other collaborators — right from inside the document

•

View your document's revision history and roll back to any previous version

•

Download a Google document to your desktop as a Word, OpenOffice, RTF, PDF, HTML or zip file

•

Translate a document to a different language

•

Email your documents to other people as attachments
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To learn more about Google Docs, check out the Google Docs getting started guide
(https://support.google.com/drive/bin/answer.py?hl=en&answer=143206&topic=21008&rd=1).
Google Sheets

Google Sheets is an online spreadsheet app that lets you create and format spreadsheets and simultaneously work
with other people. Here's what you can do with Google Sheets:
•

Import and convert Excel, .csv, .txt and .ods formatted data to a Google spreadsheet

•

Export Excel, .csv, .txt and .ods formatted data, as well as PDF and HTML files

•

Use formula editing to perform calculations on your data, and use formatting make it look the way you'd like

•

Chat in real time with others who are editing your spreadsheet

•

Create charts with your data

•

Embed a spreadsheet — or individual sheets of your spreadsheet — on your blog or website

For more information about Google spreadsheets, check out the Google Sheets getting started guide
(https://support.google.com/drive/bin/answer.py?hl=en&answer=140784&topic=20322&rd=1)
Google Slides

Google Slides is an online presentations app that allows you to show off your work in a visual way. Here's what you
can do with Google Slides:
•

Create and edit presentations

•

Edit a presentation with friends or coworkers, and share it with others effortlessly

•

Import .pptx and .pps files and convert them to Google presentations

•

Download your presentations as a PDF, a PPT, or a .txt file

•

Insert images and videos into your presentation

•

Publish and embed your presentations in a website

For more information about Google presentations, check out the Google Slides getting started guide
(https://support.google.com/drive/bin/answer.py?hl=en&answer=126127&topic=19431&rd=1)

Creating a Survey Using Google Forms
Create a Google form

Google Forms is a useful tool to help you plan events, send a survey, give students a quiz, or collect other
information in an easy, streamlined way. A Google form can be connected to a Google spreadsheet. If a
spreadsheet is linked to the form, responses will automatically be sent to the spreadsheet. Otherwise, users can
view them on the “Summary of Responses” page accessible from the Responses menu.
You can create a form from your Drive or from any existing spreadsheet.
A tour of Google Forms

(http://www.youtube.com/watch?v=xEY10Ub-k-U&feature=player_embedded)
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An overview of Google Forms. Learn how to create a form, add questions, share your form with collaborators, send
it to friends, and view responses to your form.
Create a form from your Drive:

1. Click the red Create button, then Form.
2. In the form template that opens, you can add any questions you'd like. You can also organize your form by
adding headers and dividing your form into several pages. Learn more about editing your form
(http://support.google.com/drive/bin/answer.py?hl=en&answer=2839737).

Create a form from a Google spreadsheet:

1. While working with a spreadsheet, click the Insert menu and select Form.
2. A message will display at the top of the page notifying you that a new form has been created.

3. Click Add questions here to begin editing your form, or Dismiss to get rid of this message and continue
editing your spreadsheet. (Note: If you dismiss this message, you can edit your form at any time by
selecting the Form menu and clicking Edit form.)
4. After creating a form from a Google spreadsheet, you’ll notice a new tab at the bottom of your spreadsheet
labeled “Form responses.” As you might have guessed, this is where responses to your form will be added.
After you’ve created your form, you can add and edit questions, headers, and page breaks. You can also choose
how to collect responses to your form.

Add and edit questions, headers, images, and page breaks
Once you’ve created a form, you’re ready to start adding the questions you’d like to ask. If you’d like to give your
form some structure, you can also add section headers and page breaks.
Add questions, headers, and page breaks
Add a question

To add a question to your form, click the arrow next to the Add item button and select from the following question
types:
• Text — respondents provide short answers
• Paragraph text — respondents provide longer answers
• Multiple choice — respondents select one option from among several
• Checkboxes — respondents select as many options as they’d like
• Choose from a list — respondents select one option from a dropdown menu
• Scale — respondents rank something along a scale of numbers (e.g., from 1 to 5)
• Grid — respondents select a point from a two-dimensional grid
• Date — respondents use a calendar picker to enter a date
• Time — respondents select a time (either a time of day or a duration of time)
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Clicking the Add item button — and not the arrow — will initially give you the default question type, text. Once
you’ve added a question, you can change its type by selecting from the Question type menu.
When you’ve selected your question type, you can then fill in the possible responses to your question. If you want to
further explain your question, add a description to the Help text field. If you want to prevent respondents from
leaving a question blank, check the Required question box, which makes sure users answer a question before
submitting your form.
Add a section header

If you'd like to divide your form into sections to make it easier to read and complete, add a section header. From
the Insert menu, select Section header.
For each section header, you can add both a section title and a section description.
Add an image

To add an image to your form, click the Insert menu, and select Image. Once you've uploaded the image, you can
give it a title and specify what text will appear when someone hovers over the image.
Images in forms aren't attached to or associated with form questions. You can change the position of an image by
dragging it up or down in your form.
Add a page break

If your form is lengthy and you’d like to make it easier for respondents to fill it out, you can add page breaks. From
the Insert menu, select Page break. New pages, like section headers, can have both a page title and a page
description.
Edit your form
Edit questions, headers, and page breaks

For each question, header, and page break you’ve added to your form, you can perform the following actions:
•

Edit: To edit an existing item, just click the Edit button

•

Duplicate: To duplicate an item, click the Duplicate button
duplicate.

•

Delete: To delete an item, click the Delete button

to the right of the question you want to edit.
to the right of the question you want to

to the right of the question you want to delete.

Choose a form response destination
After you’ve sent out your form, Google Forms will begin collecting the responses you receive. You'll be asked to
choose how you’d like to store these responses. (Note: You can make this choice at any time while editing your
form by clicking the Choose response destination button in the toolbar.)
You can choose either to send responses to a spreadsheet, or you can store them only in Forms. If you choose to
store them in a spreadsheet, you’ll be able to see individual responses as they come in. If you choose to store them
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in Forms, you’ll be able to see a summary of all the responses you’ve received, and you’ll also be able to download
the responses as a CSV file.
Store responses in a spreadsheet

In the “Choose response destination” dialog, you can choose to create a new spreadsheet in which to store your
form’s responses. You can give the new spreadsheet whatever title you’d like. If you’d like all of your forms to
collect responses in a new spreadsheet in the future, make sure the checkbox next to “Always create a new
spreadsheet” is selected.
Alternatively, you can choose to collect responses in a new sheet of an existing spreadsheet. Choose “New sheet in
an existing spreadsheet...” and click Choose. You’ll see a list of your spreadsheets. Pick a spreadsheet by
checking the box next to it and click Select. A new sheet will be created in that spreadsheet, and your form
responses will appear there.
Once you’ve chosen to store form responses in a spreadsheet, the Choose response destination button in the
toolbar will turn into a View responses button. Click this to see your spreadsheet. You can also find the
spreadsheet in your Drive.
Note that responses sent to a spreadsheet are essentially a copy of your responses and are only sent one way —
form to spreadsheet, not spreadsheet to form. In other words, if you modify a response in your spreadsheet, you’re
not changing the original response, which will show up in summary view or the CSV download.
Keep responses only in Forms

If you don’t want responses to go to a spreadsheet, click the Keep responses only in Forms button. Then, to
access the responses you’ve collected, click the File menu, select Download as, and click Comma Separated
Values.
Keeping responses in Forms is a good way to go if you expect your form to receive heavy traffic or a significant
number of responses, as spreadsheets will hold only the first 400,000 cells of response values. Your form's
summary view, as well as the results you download as a CSV, will always reflect all of the form responses that are
submitted, even beyond these limits.
Change your response destination

If you’ve chosen a spreadsheet in which to store your form responses, you can change this destination at any time
by clicking on the Responses menu in Forms and selecting Change response destination. You’ll be taken back
to the “Choose response destination” dialog, where you can create a new spreadsheet or send responses to
another existing spreadsheet.
Unlink a response spreadsheet

You can also choose to unlink your form from a spreadsheet at any given time by clicking on the Responses menu
in Forms and selecting Unlink form. The spreadsheet will no longer receive new responses, but responses will
continue to be stored in Forms, available as a real-time summary or as a CSV file. You can choose to re-link your
form to a spreadsheet at any time with no responses lost or deleted.
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Prezi!
•

Getting Started (http://prezi.com/support/)

Google Calendar

Organizing your schedule shouldn’t be a burden. With Google Calendar, it’s easy to keep track of life’s important
events all in one place.
1. Share your schedule (https://support.google.com/calendar/answer/36598)
Let your co-workers, family, and friends see your calendar, and view schedules that others have
shared with you. When you know when everyone is free or busy, scheduling is a snap.
2. Get your calendar on the go (https://support.google.com/calendar/topic/13950)
With two-way syncing to your mobile phone’s built-in calendar or a mobile version of Google Calendar
that’s made for the small screen, you can access your calendar while you’re away from your desk.
3. Never forget another event again (https://support.google.com/calendar/topic/1672527)
Customizable reminders help you stay on schedule. You can choose to be notified by email or get a
text message sent right to your mobile phone.
4. Send invitations and track RSVPs (https://support.google.com/calendar/answer/37161)
Invite other people to events on your calendar. Guests can RSVP to your events by email or via
Google Calendar.
5. Sync with your desktop applications (https://support.google.com/calendar/?rd=1#topic=1665163)
Access your calendar however and whenever you want by syncing events with Apple iCal and Mozilla
Sunbird.
6. Work offline (https://support.google.com/calendar/answer/1340696)
Know where you’re supposed to be even when you don’t have internet access. With offline access,
you can view a read-only version of your calendar no matter where you are.
7. All this is free? (https://support.google.com/calendar/answer/37025)
Yep.

Weebly
•

Beginner’s Guide (http://help.weebly.com/beginners-guide.html)

Practical Money Skills (http://www.practicalmoneyskills.com/index.php)
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